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Chapter​ ​1:​ ​Introduction 
“THE INTERNET HAS BEEN THE MOST FUNDAMENTAL CHANGE DURING MY LIFETIME AND FOR HUNDREDS OF YEARS. SOMEONE THE OTHER DAY SAID, “IT'S THE                       
BIGGEST​ ​THING​ ​SINCE​ ​GUTENBERG,”​ ​AND​ ​THEN​ ​SOMEONE​ ​ELSE​ ​SAID​ ​“NO,​ ​IT'S​ ​THE​ ​BIGGEST​ ​THING​ ​SINCE​ ​THE​ ​INVENTION​ ​OF​ ​WRITING.” -​ ​RUPERT​ ​MURDOCH 

Product 
Ecava IntegraXor (IGX) is HMI/SCADA software with graphic animation, real time device connectivity,                         
alarm functions, database logging, trending and reporting as basic functions. It is designed from                           
ground up using web technologies to create a complete tool for building sophisticated and intelligent                             
real-time​ ​control​ ​and​ ​monitoring​ ​systems. 
 

Purpose 
The purpose of this document is to give you some instructions on how to get started with Ecava IGX.                                     
Various tools in Ecava IGX will be utilized to create a simulated candy factory. The examples in this                                   
tutorial are meant to give initial guidance on how to use Ecava IGX and to assist you to quickly create                                       
and​ ​implement​ ​projects​ ​based​ ​on​ ​their​ ​own​ ​requirements. 
 

Dependencies 
Before​ ​we​ ​begin,​ ​ensure​ ​you​ ​have​ ​the​ ​following​ ​applications​ ​installed.  

1) Ecava​ ​IGX​ ​SCADA 
2) Graphic​ ​Editor​ ​Inkscape​ ​SAGE 

 
If​ ​you​ ​do​ ​not​ ​have​ ​any​ ​of​ ​the​ ​above​ ​programs,​ ​go​ ​to​ ​​https://www.integraxor.com/download-scada/​​ ​to 
download​ ​them​ ​for​ ​FREE​ ​and​ ​install​ ​them​ ​on​ ​your​ ​PC.  

System​ ​Requirements 
 
Operating​ ​System  Microsoft​ ​Windows​ ​7​ ​or​ ​above. 

Processor  Intel​ ​©​ ​Core​ ​™​ ​2​ ​@​ ​1.66GHz 

Disk​ ​Space  ~25MB​ ​for​ ​Runtime  
~200MB​ ​for​ ​Development 

Memory  4GB 

Runtime​ ​(web​ ​browser)  Mozilla​ ​Firefox​ ​3.5+,  
Google​ ​Chrome​ ​3.0+,​ ​or 
Microsoft​ ​Internet​ ​Explorer​ ​8+​ ​(with​ ​Adobe​ ​SVG​ ​Viewer*​ ​plugin) 

 
*If​ ​you​ ​must​ ​use​ ​IE​ ​8​ ​or​ ​below,​ ​please​ ​download​ ​Adobe​ ​SVG​ ​Viewer​ ​plugin​ ​at: 
http://download.adobe.com/pub/adobe/magic/svgviewer/win/3.x/3.03/en/SVGView.exe 
 
 

(c)​ ​2017​ ​Ecava Page​ ​4​​ ​of​ ​49 Revision:​ ​6.1.1130.2 

https://www.integraxor.com/download-scada/?utm_source=tutorial&utm_medium=download-link&utm_content=dependency&utm_campaign=tutorial
http://download.adobe.com/pub/adobe/magic/svgviewer/win/3.x/3.03/en/SVGView.exe


 

Also, as a truly web based product, Ecava IGX utilizes HTML and JavaScript as the programming                
languages. If you are not familiar with any one of the languages, do not worry. We will show you the                    
basics. Have confidence that many people know these two programming languages and resources are              
widely​ ​available​ ​on​ ​the​ ​Internet. 
 

Industrial​ ​Automation​ ​Basics 
If you have used a HMI/SCADA application or a PLC before, you may skip the next chapter. If you are                    
new to SCADA or industrial automation, you will need some basic knowledge of industrial automation,               
communication​ ​protocols​ ​and​ ​the​ ​concept​ ​of​ ​tags/points​ ​which​ ​you​ ​will​ ​learn​ ​in​ ​the​ ​next​ ​chapter. 
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Chapter​ ​2:​ ​Basic​ ​Knowledge 

 

Programmable​ ​Logic​ ​Controllers​ ​(PLC) 
A programmable logic controller (PLC) is a microprocessor based device used for automation             
processes, such as control of machinery on a factory assembly line, or control of boxing machines and                 
conveyor lines. A key feature of a PLC is the facility for input/output (I/O) which connects to sensors                  
and actuators. Through these I/Os, a PLC can read limit switches, analog process variables (such as                
temperature and pressure), and the positions of complex positioning systems. A PLC can also operate               
electric​ ​motors,​ ​magnetic​ ​relays​ ​or​ ​solenoids,​ ​pneumatic​ ​or​ ​hydraulic​ ​cylinders​ ​or​ ​analog​ ​outputs. 
 
They are one of the most versatile and common devices used for industrial automation. They monitor                
the​ ​inputs,​ ​solve​ ​logic​ ​of​ ​a​ ​user​ ​program​ ​and​ ​control​ ​the​ ​outputs. 
 

Data​ ​&​ ​Communications 
There is a wealth of information inside a PLC. Information such as math calculations or the input state                  
of a device is stored in PLC's data areas. Data areas are internal memory registers of a PLC, each with                    
its own memory address. These data are accessible from external systems via communication ports              
built in a PLC. Usually, a PLC will have a 9-Pin serial RS232 port with Modbus included as one of the                     
communications protocols. Optionally, there may be Ethernet ports or various filed buses for protocols              
such DeviceNet or Profinet. For example, the running state of a motor is available to the PLC via input                   
1. Depending on the make of the PLC, the register address for input 1 may be mapped to the Modbus                    
address​ ​10001.  
 

PLC​ ​&​ ​Ecava​ ​IGX 
Ecava IGX is a tool to develop HMI/SCADA applications. Ecava IGX provides common communication              
drivers to exchange data directly with a PLC via its communication port. In the above example, in order                  
to read the motor running state into Ecava IGX, we need to create a port, provide the PLC                  
configuration in Ecava IGX Project Editor and create a digital I/O tag which corresponds to the Modbus                 
address 10001. Ecava IGX Server will poll the PLC via the communication port and update the tag with                  
real-time​ ​information. 
 
Apart from PLCs, Ecava IGX can also communicate with various other devices such as robots and                
drives​ ​that​ ​support​ ​commonly​ ​used​ ​industrial​ ​communication​ ​protocols. 
 
Ecava IGX also provides tools to draw graphical user interface for the user. For example, a simple tank                  
can be represented by a rectangle and animated with the rising and falling of its water level. Alarms                  
can be configured using Ecava IGX for early detection and warning. Database logging, trends and               
many other tools are also available in Ecava IGX. The flexibility of Ecava IGX and the use of modern                   
web​ ​technologies​ ​allow​ ​limitless​ ​possibilities​ ​for​ ​your​ ​automation​ ​system​ ​on​ ​a​ ​global​ ​level. 
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Figure​ ​2.1​ ​:​ ​Ecava​ ​IGX​ ​basic​ ​network​ ​architecture 
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The​ ​screenshot​ ​below​ ​shows​ ​a​ ​project​ ​homepage​ ​developed​ ​with​ ​Ecava​ ​IGX. 
 

Figure​ ​2.2​ ​:​ ​Ecava​ ​IGX​ ​project​ ​screenshot​ ​(for​ ​a​ ​plant​ ​process)  
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Chapter​ ​3:​ ​Project​ ​Overview 
 

Candy​ ​Factory 
In​ ​this​ ​tutorial,​ ​we​ ​will​ ​create​ ​a​ ​new​ ​Ecava​ ​IGX​ ​project​ ​to​ ​monitor​ ​and​ ​control​ ​a​ ​simple​ ​candy​ ​factory.  
 

New​ ​Project 
Click Start > Programs > Ecava IGX > IntegraXor Editor. This will open Ecava IGX Project Editor or in                                     
short,​ ​PE,​ ​where​ ​you​ ​will​ ​configure​ ​the​ ​SCADA​ ​project. 
 
On​ ​the​ ​PE,​ ​click​ ​File​ ​>​ ​New​ ​Project​ ​to​ ​create​ ​a​ ​new​ ​project. 

 
Figure​ ​3.1​ ​:​ ​Creating​ ​a​ ​new​ ​project​ ​with​ ​Ecava​ ​IntegraXor​ ​Project​ ​Editor 

 
Name the project 'Candy'. You may create it in any directory. For this tutorial, we will create the                                   
Candy project in a directory called “C:\Documents\IntegraXor Projects”. You need to create the                         
directory​ ​first​ ​before​ ​you​ ​can​ ​select​ ​it​ ​in​ ​the​ ​'Create​ ​New​ ​Project'​ ​dialog​ ​box. 
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Figure​ ​3.2​ ​:​ ​Create​ ​New​ ​Project​ ​dialog​ ​box 

 

Project​ ​Management 
In the project location, a new folder with the project name 'Candy' will be created. The project file                                   
‘Candy.igx’ will be created inside this folder along with several other files and directories. This 'Candy'                               
folder will be your project folder. You may copy this folder to another location for backup or to                                   
distribute​ ​the​ ​project. 
 
The PE interface consists of a tree view on the Task window on the left side, multiple tabs showing the                                       
project configuration on the right side and an Output window (which can be hidden) showing status,                               
warning and error messages. The items in the Task window are General, Timer, Tag, Database,                             
Security,​ ​Alarm,​ ​Script,​ ​Screen,​ ​Report,​ ​etc. 
 
After creating a new project, look for ‘General’ on the left pane. Click on it, check to ensure that the                                       
new​ ​project​ ​name​ ​is​ ​configured​ ​in​ ​the​ ​Project​ ​ID​ ​entry,​ ​as​ ​well​ ​as​ ​other​ ​project​ ​properties. 
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Figure​ ​3.3​ ​:​ ​Candy​ ​project​ ​General​ ​properties 

 

Running​ ​the​ ​Project 
From the PE, click 'Run Project' on the toolbar or hit the F5 key. Ecava IGX Server will run. It requires                     
Administrator privilege to run. If you enable User Account Control (UAC) on your PC, a message                
asking for your permission to run Ecava IGX Server will pop up. You must choose 'Yes' in order to run                    
the​ ​server. 
 
The server shows the details of the tasks running behind Ecava IGX. This information is useful in                 
monitoring​ ​the​ ​tasks​ ​as​ ​well​ ​as​ ​troubleshooting​ ​or​ ​diagnosing​ ​errors.  
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Figure​ ​3.4​ ​:​ ​Ecava​ ​IntegraXor​ ​server 
 
Then, Internet Explorer will open the following page with the URL http://localhost:7131/Candy/. You             
might have noticed the automatic launch of the web browser is configured in the Post-launch under the                 
General​ ​item.  
 

Figure​ ​3.5​ ​:​ ​IntegraXor​ ​project​ ​on​ ​Internet​ ​Explorer  
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There is a built-in web server that delivers pages such as index.html in Ecava IGX Server. It uses port                   
7131 by default. If there are more than one computing devices in your local network, go ahead and                  
view your project with your browser on another computer or on a smartphone in the same network.                 
Enter the appropriate project URL in your browser. For example, if Ecava IGX Server is running on a                  
computer with an IP address of 192.168.1.100 and is listening to port 7131, the URL is                
http://192.168.1.100:7131/Candy/.​ ​You​ ​are​ ​now​ ​viewing​ ​the​ ​project​ ​as​ ​a​ ​remote​ ​client. 
 

Quiz​ ​1 
1. Please create a new project named after your initials (e.g. Albert B. Colin as ABC) in My Documents                   
> IntegraXor Projects folder. Run the project, print screen the Overview page and save the screenshot                
as​ ​01Overview.png​ ​in​ ​My​ ​Documents​ ​>​ ​IntegraXor​ ​Projects​ ​>​ ​<your​ ​initials>​ ​>​ ​Quiz​ ​folder*. 
 
2. In your local network, run your project in Ecava IGX Server on one of your PCs. This PC will be the                      
server. Access the project URL with a browser on another PC, which is the remote client. On the client                   
PC, print screen the Overview page and save the screenshot as 02Remote.png in My Documents >                
IntegraXor​ ​Projects​ ​>​ ​<your​ ​initials>​ ​>​ ​Quiz​ ​folder. 
 
*Note:​ ​You​ ​must​ ​first​ ​create​ ​a​ ​new​ ​folder​ ​named​ ​Quiz​ ​in​ ​your​ ​project​ ​folder. 
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Chapter​ ​4:​ ​Device​ ​Configuration 
 

3​ ​Steps 
Ecava IGX reads data from a device by polling it through a communication port. The configuration in                 
Ecava IGX PE is divided into 3 simple steps. First, assume we have a PLC controlling the whole candy                   
factory. The PLC, which connects to a Modbus device, is also connected to a computer via a serial                  
RS232 port (COM2). Ecava IGX Server runs on the computer and reads data from the PLC through                 
COM2. 
 
Step​ ​1:​ ​Create​ ​a​ ​Port 
Port is the first channel to determine in accessing external devices. A port can be a serial                 
communication port, an Ethernet port, any physical connection to an external device or virtual              
connection​ ​to​ ​a​ ​simulator​ ​program. 
 
Parameter Description 
Enable Enabled​ ​(Checked)​ ​/​ ​Disabled​ ​(Unchecked) 

Name A​ ​unique​ ​name​ ​for​ ​the​ ​port 

Description Additional​ ​description 

Address Physical​ ​port​ ​address 

Interval Delay​ ​between​ ​devices​ ​in​ ​serial​ ​link​ ​or​ ​slow​ ​devices. 
 
By default, COM1 and Ethernet localhost ports (ETH01 & OPC) are created for every new project. In                 
this tutorial, we will create a new serial RS232 port called COM2. Expand the Tag item on the left and                    
click the IO Driver to open the Port tab. Add a new port COM2, disable the other ports and save your                     
changes. 
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Figure​ ​4.1​ ​:​ ​Create​ ​New​ ​Port 

 
Step​ ​2:​ ​Create​ ​a​ ​Device 
One or more devices can be connected to the HMI/SCADA system via one defined Port. The Device                 
table​ ​defines​ ​the​ ​settings/behavior​ ​of​ ​the​ ​connected​ ​device(s). 
 
Parameter Description 
Enable Enabled​ ​(Checked)​ ​/​ ​Disabled​ ​(Unchecked) 

Name A​ ​unique​ ​name​ ​for​ ​the​ ​device 

Description Additional​ ​description 

Timer Define​ ​the​ ​polling​ ​interval​ ​to​ ​read​ ​data​ ​from​ ​the​ ​device 

Driver This column specifies the communication protocol used. Select a         
communication​ ​protocol​ ​from​ ​the​ ​drop-down​ ​menu. 

Path String​ ​type​ ​node​ ​address 

Address Numerical​ ​type​ ​node​ ​address 

Maximum 
Connections 

Maximum​ ​allowable​ ​connections​ ​per​ ​device 
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Click on COM2 on the left to open the Device table to add a new device. Give it a name, say “PLC02”.                      
We will use Modbus RTU as the communication protocol with a Baud rate of 19200 and with even                  
parity bit. Assign SEC01 as the timer so that the server will read data from the PLC every second. After                    
completing​ ​the​ ​configuration,​ ​save​ ​the​ ​changes. 

 
Figure​ ​4.2​ ​:​ ​Create​ ​New​ ​Device 

 
Step​ ​3:​ ​Create​ ​Tags 
'Tag' is a common term in SCADA. A tag is similar to a ​variable ​in computer programming. A variable                    
refers to a memory location in the computer, while a tag refers to a memory location in the PLC. There                    
are three types of tags in Ecava IGX, which are external IO (xio), virtual IO (vir) and runtime (run). ​Both                    
external IO and virtual IO tags must be entered into their corresponding Tag tables. A tag that is                  
associated with a device is an external IO tag, otherwise it is a virtual IO tag. A tag used during runtime                     
without​ ​being​ ​defined​ ​in​ ​the​ ​Tag​ ​table​ ​is​ ​called​ ​a​ ​runtime​ ​or​ ​system​ ​tag.  
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Parameters  Descriptions 

Enable  Enabled​ ​(Checked)​ ​/​ ​Disabled​ ​(Unchecked) 

Name  A​ ​unique​ ​name​ ​for​ ​each​ ​tag 

Description  Additional​ ​description 

Address  Address​ ​in​ ​numerical​ ​format,​ ​e.g.​ ​Modbus 

Path  Address​ ​in​ ​string​ ​format,​ ​e.g.​ ​OPC 

Batch  Batch number indicating a chunk of data for one device shall be read or                           
written​ ​together​ ​if​ ​they​ ​are​ ​contiguous​ ​in​ ​data​ ​address​ ​arrangement. 
Enter​ ​-1​ ​to​ ​automatically​ ​handle​ ​grouping​ ​based​ ​on​ ​protocol​ ​selected.  
Enter​ ​0​ ​to​ ​force​ ​the​ ​tag​ ​to​ ​be​ ​read​ ​separately.  
Enter​ ​any​ ​positive​ ​integer​ ​to​ ​group​ ​tags.  

Type  The​ ​data​ ​type​ ​of​ ​the​ ​tag.​ ​The​ ​following​ ​are​ ​the​ ​available​ ​data​ ​types. 
-​ ​boolean -​ ​int16 -​ ​int32 
-​ ​int64 -​ ​int8 -​ ​uint8 
-​ ​real32 -​ ​real64 -​ ​string 
-​ ​uint16 -​ ​uint32 -​ ​uint64 

Length  The​ ​string​ ​length​ ​of​ ​the​ ​data,​ ​i.e.​ ​the​ ​number​ ​of​ ​characters​ ​in​ ​the​ ​string. 

Default  The default tag value during server startup. If it is left blank, an uninitialized                           
tag​ ​will​ ​have​ ​no​ ​value. 

Input​ ​Expression  An expression that modifies the input data to the desired value before it is                           
stored in the tag. The expression can be a scaling factor or a logical                           
expression.​ ​If​ ​it​ ​is​ ​left​ ​blank,​ ​the​ ​input​ ​data​ ​will​ ​not​ ​be​ ​modified. 

Output 
Expression 

An expression that modifies the output tag value to the desired value before                         
the modified value is written to an external device. The expression can be a                           
scaling factor or a logical expression. If it is left blank, the output data will not                               
be​ ​modified. 

Read​ ​Level  The​ ​security​ ​level​ ​(0​ ​to​ ​1000)​ ​for​ ​reading​ ​the​ ​tag. 

Write​ ​Level  The​ ​security​ ​level​ ​(0​ ​to​ ​1000)​ ​for​ ​writing​ ​the​ ​tag. 

Log  Select a database to record the tag value . This setting is required for                           
trending. 

Retentive  Select a database to record the last known tag value. This value will be                           
updated when the tag value changes. It will be assigned to the tag if the tag                               
value​ ​cannot​ ​be​ ​read​ ​from​ ​the​ ​external​ ​device​ ​successfully. 

Read​ ​Role  The​ ​security​ ​role​ ​for​ ​reading​ ​the​ ​tag. 

Write​ ​Role  The​ ​security​ ​role​ ​for​ ​writing​ ​the​ ​tag. 

Input​ ​Tag  Set​ ​true​ ​for​ ​Modbus​ ​1x​ ​and​ ​3x​ ​address​ ​and​ ​make​ ​a​ ​tag​ ​Read​ ​Only.  

Attribute  The​ ​attributes​ ​for​ ​the​ ​tag​ ​behavior​ ​are​ ​as​ ​below:- 
-​ ​Write-only​ ​tag 
-​ ​Log​ ​value​ ​on​ ​change​ ​(only​ ​applicable​ ​if​ ​Log​ ​parameters​ ​are​ ​defined) 
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Click on 'PLC02' on the left menu to open its Tag table. We shall add a few tags to be mapped to the                       
data areas in the PLC. The Modbus addresses may differ for each make of PLC. The typical address                  
ranges​ ​are​ ​shown​ ​as​ ​follows. 
 
Typical​ ​Modbus​ ​address​ ​ranges 
​ ​Description  ​ ​Modbus​ ​address 

​ ​Coils​ ​Status​ ​(Digital​ ​Output)  ​ ​00000-09999 

​ ​Inputs​ ​Status​ ​(Digital​ ​Input)  ​ ​10000-19999 

​ ​Input​ ​Register​ ​(Analog​ ​Input)  ​ ​30000-39999 

​ ​Holding​ ​registers​ ​(Analog​ ​Output)  ​ ​40000-49999 

 

Figure​ ​4.3​ ​:​ ​Tag​ ​configuration 
 
Since we will not be using an actual PLC in this tutorial, we will use virtual tags as a replacement.                    
Virtual tags are internal tags that are not tied to any physical I/O. You can use these tags as variables                    
to store data. These virtual tags are not included in the final licensed I/O count so you can create as                    
many​ ​virtual​ ​tags​ ​as​ ​you​ ​want. 
 
Open COM2 table to disable the device PLC02. Ecava IGX will not poll a device configured in a port if                    
the​ ​device​ ​is​ ​disabled.​ ​You​ ​can​ ​also​ ​remove​ ​the​ ​device​ ​by​ ​deleting​ ​the​ ​whole​ ​row​ ​of​ ​device​ ​data. 
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Under​ ​the​ ​Tag​ ​item,​ ​click​ ​Virtual​ ​and​ ​create​ ​the​ ​following​ ​tags: 
 
​ ​Tag​ ​name ​ ​Data​ ​type 
​ ​level_chocolate ​ ​real32 

​ ​level_syrup ​ ​real32 

​ ​level_vanilla ​ ​real32 

​ ​level_strawberry ​ ​real32 
 
The​ ​other​ ​settings​ ​can​ ​remain​ ​as​ ​default. 
 

Figure​ ​4.4​ ​:​ ​Virtual​ ​Tags 
 
Run your project in Ecava IGX Server. In the server, you can select one of the above tags in the Watch                     
window. For example, to see the 'level_syrup' tag value, enter its name in the search bar on the Watch                   
window. You can enter a new value, say 10.5 and press Enter to change the tag value. You can also                    
add​ ​the​ ​tag​ ​to​ ​your​ ​watch​ ​list​ ​to​ ​monitor​ ​the​ ​value​ ​by​ ​clicking​ ​the​ ​star​ ​icon​ ​on​ ​the​ ​left​ ​side​ ​of​ ​the​ ​tag. 
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Figure​ ​4.5​ ​:​ ​Tags​ ​in​ ​the​ ​watch​ ​list 
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Quiz​ ​2 
1.​ ​Open​ ​PE.​ ​Create​ ​the​ ​Modbus​ ​IO​ ​tags​ ​based​ ​on​ ​the​ ​list​ ​below: 
Configuration​ ​details: 

IP​ ​and​ ​port​ ​number:​ ​127.0.0.1:502 
Protocol:​ ​Modbus​ ​TCP/IP 
Timer:​ ​SEC01 

IO​ ​List 
Item ​ ​Description ​ ​Address* Type Input 
A ​ ​​Operator​ ​Interface    

1 ​ ​System​ ​Fault​ ​Alarm​ ​Beacon 0 boolean No 

2 ​ ​Auto/Manual​ ​Select​ ​Switch 3 boolean Yes 

B ​ ​​Pump​ ​Control     

1 ​ ​Pump​ ​Start/Stop​ ​Command 1 boolean No 

2 ​ ​Pump​ ​Run/Stop 4 boolean Yes 

3 ​ ​Pump​ ​Trip 5 boolean Yes 

C ​ ​​Valve​ ​Control    

1 ​ ​Valve​ ​Open/Close​ ​Command 3 boolean No 

2 ​ ​Valve​ ​Fully​ ​Open 8 boolean Yes 

3 ​ ​Valve​ ​Fully​ ​Close 9 boolean Yes 

D ​ ​​Instrument    

1 ​ ​Reservoir​ ​Tank​ ​Level​ ​(0​ ​-​ ​10000m​3​) 0 int16 Yes 

2 ​ ​Reservoir​ ​Tank​ ​pH​ ​(pH​ ​0​ ​–​ ​14) 1 int16 Yes 

3 ​ ​Reservoir​ ​Tank​ ​Outlet​ ​Flow​ ​Rate​ ​(0​ ​-​ ​1000m​3​/h) 2 int16 Yes 

4 ​ ​Reservoir​ ​Tank​ ​Outlet​ ​Flow​ ​Totalizer 3 int16 Yes 
 
After you have finished entering all of the items above, print screen your PE and save the following:                  
Port table as 03Port.png, Device table as 04Device.png and Tag table as 05Tag.png in My Documents                
>​ ​IntegraXor​ ​Project​ ​>​ ​<your​ ​initials>​ ​>​ ​Quiz​ ​folder. 
 
*Note: The addresses are not absolute Modbus addresses. An address is entered as an offset               
from the first address of the register of a particular data type. For example, address 0 for                 
read-only (input) boolean type is usually Modbus address 10001. Address 3 will be Modbus              
address​ ​10004.​ ​To​ ​determine​ ​the​ ​address​ ​for​ ​a​ ​data​ ​type,​ ​use​ ​the​ ​following​ ​formula: 

address​ ​=​ ​actual​ ​Modbus​ ​address​ ​-​ ​first​ ​Modbus​ ​address​ ​-​ ​address​ ​offset 
 
The actual address and the first address must belong to the same data type. The address                
offset​ ​is​ ​a​ ​setting​ ​for​ ​a​ ​device.​ ​Its​ ​default​ ​value​ ​is​ ​0.​ ​Refer​ ​to​ ​Figure​ ​4.2​ ​for​ ​the​ ​setting. 
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For more information about Modbus addresses, please refer to the Modbus specification            
document​ ​which​ ​can​ ​be​ ​downloaded​ ​online.  
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Chapter​ ​5:​ ​Graphical​ ​Animation 
 

Inkscape​ ​SAGE​ ​(SCADA​ ​Animation​ ​Graphic​ ​Editor) 
Using Windows Explorer, go to “C:\Documents\IntegraXor Projects\Candy”. Right click on overview.svg           
and open it with an application called Inkscape SAGE. Inkscape SAGE is the tool for drawing graphics                 
and​ ​configuring​ ​animation​ ​based​ ​on​ ​your​ ​tags. 
 

In Inkscape SAGE, select the Rectangle tool (F4) by clicking on icon. Drag to create a rectangle in                   

overview.svg.​ ​Click​ ​on​ ​Select​ ​tool​ ​(F1)​ ​by​ ​clicking​ ​on​ ​ ​ ​icon​ ​to​ ​return​ ​to​ ​selection​ ​mode. 
 

Figure​ ​5.1​ ​:​ ​Inkscape​ ​SAGE​ ​draw​ ​rectangle 
 
This rectangle will be used to animate a tank fill level in your candy factory. You can change the color                    
and border style of your tank level by selecting menu Object > Fill and Stroke (right click and select Fill                    
and​ ​Stroke​ ​or​ ​press​ ​SHIFT+CTRL+F) 
 
Next, right click on the tank and select Object Properties (select menu Object > Object Properties or                 
press SHIFT+CTRL+O). Select 'Bar' animation, enter app.currentTime.second in Tag field. The tag            
called app.currentTime.second is an Application (server's internal) tag which contains the current time             
value of seconds. Enter 0 in the Min field and 59 in the Max field. Click OK. Select menu File > Save or                       
press​ ​CTRL+S​ ​to​ ​save​ ​overview.svg. 
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Figure​ ​5.2​ ​:​ ​Object​ ​Properties​ ​–​ ​Bar​ ​Animation 
 
Return to Internet Explorer, press F5 to refresh (after running the Ecava IGX project). You will see the                  
level of your tank changing every second. Congratulations! You have successfully created a basic              
graphic​ ​animation​ ​in​ ​Ecava​ ​IGX. 
 
You can draw another rectangle to show the outline of the tank. Use gradients in the Fill and Stroke to                    
create a 3D effect. Change the thickness and style of the object's outline or stroke. Try changing the                  
opacity​ ​(visibility)​ ​and​ ​see​ ​the​ ​effects. 
 
Now, create 4 tanks for chocolate, strawberry, vanilla and syrup. Use the tags you created earlier and                 
configure​ ​Bar​ ​animation​ ​for​ ​each​ ​tank​ ​with​ ​Min​ ​0​ ​and​ ​Max​ ​100.  
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Get​ ​Tag​ ​&​ ​Set​ ​Tag 
Apart from graphic visualization of the level, we also need some text visualization. The Text tool is easy                  
to find. On the left, select the Text tool (F8) with a Capital A as an icon. Click on an empty area in                       
overview.svg​ ​and​ ​key​ ​in​ ​'Vanilla'.​ ​Now,​ ​you​ ​can​ ​label​ ​the​ ​rest​ ​of​ ​your​ ​tanks. 
 

Figure​ ​5.3​ ​:​ ​Adding​ ​Text 
 
We also need to display the tank level in figures. Create another text box and enter #.## as text. Open                    
Object​ ​Properties,​ ​select​ ​'Get'​ ​animation​ ​and​ ​enter​ ​level_vanilla​ ​in​ ​the​ ​tag​ ​field.​ ​Click​ ​Apply. 

 
Figure​ ​5.4​ ​:​ ​Get​ ​Tag 

Select 'Set' animation and enter level_vanilla. Click OK and save overview.svg. Refresh your Internet              
Explorer​ ​to​ ​see​ ​the​ ​changes.​ ​Try​ ​to​ ​click​ ​on​ ​the​ ​text​ ​and​ ​enter​ ​a​ ​real/float​ ​value.  
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Figure​ ​5.5​ ​:​ ​Set​ ​Tag 
 

Tip: #.## formats the display of your data. Click on the text to edit. Add '#' after the decimal point;                    
#.###, refresh your Internet Explorer and you will see the difference. By adding '#' after decimal point in                  
the​ ​text,​ ​you​ ​are​ ​specifying​ ​how​ ​many​ ​decimal​ ​places​ ​you​ ​want​ ​to​ ​display​ ​on​ ​your​ ​screen. 
 

Web​ ​Buttons 
Buttons are used widely in industry. Start, Stop, Run, Open and Close are some of the more common                  
uses of a button. Here, we would like to create a button to top-up our tank to 100. Draw a rectangle.                     
Open Object Properties, select 'Set' animation and enter level_vanilla. In the Source field, enter 100.               
Use​ ​the​ ​text​ ​tool​ ​to​ ​name​ ​your​ ​button,​ ​'Top-up'.​ ​Save​ ​and​ ​refresh.​ ​Click​ ​on​ ​the​ ​button​ ​to​ ​set​ ​it​ ​to​ ​100. 
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Figure​ ​5.6​ ​:​ ​Button​ ​Action 
 

Tip: There are numerous tutorials on the Internet on how to draw Web 2.0 buttons with Inkscape. 3D,                  
gel and shadow effects make the overall look of your graphics more pleasing. Do a search for                 
“Inkscape​ ​button​ ​tutorial”​ ​online. 
 

Slider​ ​Movement 
For a straight line linear movement between 2 points, you can use the slider animation. First, create an                  

object. Here we will draw a piece of candy using the Spiral tool ( icon / F9) and Straight line tool (                     

icon / SHIFT+F6). Press shift and click on both objects. Select menu Object > Group (or hit                  
CTRL+G). 
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Figure​ ​5.7​ ​:​ ​Group​ ​objects 
 

Next, right click on the grouped object and select Object Properties. In the Slider tab, enter                
app.currentTime.second​ ​in​ ​the​ ​tag​ ​field,​ ​Min​ ​0​ ​and​ ​Max​ ​59.​ ​Click​ ​OK. 
 

Figure​ ​5.8​ ​:​ ​Slider​ ​Animation 
Click on the grouped object, select Edit > Clone > Create Clone (or hit ALT+D). A clone object will be                    
created right on top of the original. Click on top (clone) object and place it at the Max destination. This                    
piece of candy will travel from the original position to the Max position based on time in seconds. Save                   
the​ ​SVG​ ​and​ ​refresh​ ​your​ ​Internet​ ​Explorer. 
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Figure​ ​5.9​ ​:​ ​Clone​ ​object 
 

Tip: If you modify the original object, all cloned objects will be automatically modified as well. However,                 
ungroup action (CTRL+U) will remove all group animation. In order to keep the group animation, right                
click​ ​on​ ​the​ ​group​ ​and​ ​select​ ​Enter​ ​Group.​ ​Now,​ ​you​ ​can​ ​select​ ​the​ ​individual​ ​items​ ​for​ ​modification. 
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Faceplate 
Faceplate allows user to duplicate a grouped object while keeping the same tag name. This is useful                 
when there are multiple identical objects such as pumps, valves, etc with the same animation but are                 
associated with different tags. Faceplate is available only on the Object Properties dialog box for               
grouped objects. Before applying the Faceplate settings, the user must design the object and use the                
same​ ​pattern​ ​of​ ​tag​ ​names. 
 
For example, a pump has an animation and the user wants to create two identical pumps animated by                  
two tags: pump_1_state and pump_2_state. When assigning the animation tag, the user enters the tag               
name as pump_%n_state in the Tag field instead. After the pump drawing is completed, it should be                 
grouped by pressing CTRL + G. Next, the user can duplicate the pump object by pressing CTRL + D.                   
The​ ​Faceplate​ ​settings​ ​are​ ​in​ ​the​ ​Object​ ​Properties​ ​dialog​ ​box​ ​of​ ​each​ ​pump​ ​object. 

Figure​ ​5.10​ ​:​ ​Faceplate​ ​settings​ ​on​ ​Object​ ​Properties​ ​dialog​ ​box 
 
The user needs to fill up the Variable and Value fields. Variable is the part of the tag name that is                     
different, while Value is the value that replaces the Variable when the tag name is evaluated. In our                  
case, the Variable is n and the Value should be 1 for the first pump or 2 for the second pump. The                      
symbol % is an identifier of the animation system and is not required in the Variable field. During                  
runtime, the front end script will convert the tag name from pump_%n_state to pump_1_state for the                
first​ ​pump​ ​or​ ​pump_2_state​ ​for​ ​the​ ​second​ ​pump. 
 
Several variables can be entered in separate rows for use within a grouped object. For a tag name with                   
a pattern like tag%n_%s_%d, there are three entries in the list, where the variables are n, s and d. The                    
value​ ​field​ ​should​ ​contain​ ​characters​ ​that​ ​are​ ​valid​ ​for​ ​a​ ​tag​ ​name.  
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Visibility​ ​(Opacity) 
Another way to make an object move is to make it appear in the path of the movement. Let's try this out                      
by making a mixing tank. First, draw a tank. Then, we create 4 sets of graphics with the agitator arms                    
in​ ​4​ ​different​ ​positions​ ​like​ ​this. 
 

Figure​ ​5.11​ ​:​ ​Stirrer​ ​Movement​ ​by​ ​Opacity 
 
Next,​ ​return​ ​to​ ​PE​ ​and​ ​create​ ​the​ ​following​ ​virtual​ ​tags. 
 
​ ​Tag​ ​name ​ ​Data​ ​type 
​ ​agitator_posA ​ ​boolean 

​ ​agitator_posB ​ ​boolean 

​ ​agitator_posC ​ ​boolean 

​ ​agitator_posD ​ ​boolean 
 
Return to overview.svg, right click on the first set of agitator arms and select Object Properties. Select                 
Opacity animation and enter agitator_posA in the tag field. Set maximum to 1 and minimum to 0. Do                  
the same with the other 3 sets of graphics with tags agitator_posB, agitator_posC and agitator_posD.               
Next, hold down the Shift key and click on all 4 set of agitator graphics. This selects all 4 sets together.                     
Alternatively, you can click and drag your mouse across all 4 graphics. With all 4 sets selected, go to                   
the Objects menu and select 'Align and Distribute' (or press CTRL+SHIFT+A). Align all 4 horizontally               
and vertically. This action overlaps the 4 graphics exactly on top of each other. The effect we want is                   
agitator position A to appear first then disappear. As soon as agitator position A disappears, agitator                
position B appears and this is repeated for agitator position C and D. In order to do this, we need the                     
tags​ ​to​ ​alternately​ ​set​ ​to​ ​1.​ ​We​ ​will​ ​do​ ​this​ ​with​ ​a​ ​script​ ​in​ ​the​ ​next​ ​chapter. 
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Figure​ ​5.12​ ​:​ ​Alignment​ ​of​ ​objects 

 

More​ ​Animations 
Try the Rotate and Color animations. Draw an object and use app.currentTime.second as the tag. You                
will be able to see the animation every second. Refer to Ecava IGX User Guide for the complete list of                    
available​ ​animations. 

 

Quiz​ ​3 
1. With your imagination and engineering knowledge, please draw in My Documents >             
IntegraXor Projects > <your initials> > overview.svg a simple reservoir tank system referring to              
IO​ ​list​ ​given​ ​in​ ​​Quiz​ ​2. 
 
In the screen you must show at least the tank level animation, pump run/stop/trip status and                
valve fully open/fully close status. Run your server, print screen Overview screen and save the               
screenshot as 07Mimic.png in My Documents > IntegraXor Projects > <your initials> > Quiz              
folder.  
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Chapter​ ​6:​ ​Server-side​ ​Scripting 
 

JavaScript 
One of the most popular scripting languages for the web is JavaScript. It is easy to find JavaScript                  
tutorials and examples on the Internet. JavaScript is also a very easy, flexible and powerful language to                 
learn.​ ​In​ ​this​ ​section​ ​of​ ​the​ ​tutorial,​ ​you​ ​will​ ​be​ ​writing​ ​your​ ​first​ ​JavaScript​ ​for​ ​Ecava​ ​IGX. 
 

Your​ ​First​ ​JavaScript 
In​ ​the​ ​PE,​ ​click​ ​on​ ​Script​ ​item​ ​on​ ​the​ ​left​ ​menu.​ ​Add​ ​a​ ​new​ ​script​ ​and​ ​enter​ ​the​ ​following​ ​details. 
 

Figure​ ​6.1​ ​:​ ​Create​ ​Server-side​ ​Script 
 
Save the changes you have made and a JavaScript file named run.js will be automatically created in                 
your​ ​project​ ​folder. 
 
 
 
 
 
 
 
 
 
 
Click on the newly created 'run' script to open it. Copy and paste the following into your run script. Save                    
the​ ​script. 
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//agitator​ ​rotation​ ​animation 
var​ ​ctr​ ​=​ ​getTag(​ ​'agitator_pos'); 
if​ ​(ctr​ ​<​ ​4)​ ​{ 
​ ​​ ​​ ​​ ​ctr++; 
}  

else​ ​{ 
​ ​​ ​​ ​​ ​ctr​ ​=​ ​1; 
} 

setTag(​ ​'agitator_pos',​ ​ctr); 
 

switch​ ​(ctr)​ ​{ 
​ ​​ ​​ ​​ ​case​ ​1: 
​ ​​ ​​ ​​ ​setTag(​ ​'agitator_posA',​ ​1); 
​ ​​ ​​ ​​ ​setTag(​ ​'agitator_posB',​ ​0); 
​ ​​ ​​ ​​ ​setTag(​ ​'agitator_posC',​ ​0); 
​ ​​ ​​ ​​ ​setTag(​ ​'agitator_posD',​ ​0); 
​ ​​ ​​ ​​ ​​ ​​ ​​ ​​ ​break; 
​ ​​ ​​ ​​ ​case​ ​2: 
​ ​​ ​​ ​​ ​setTag(​ ​'agitator_posA',​ ​0); 
​ ​​ ​​ ​​ ​setTag(​ ​'agitator_posB',​ ​1); 
​ ​​ ​​ ​​ ​setTag(​ ​'agitator_posC',​ ​0); 
​ ​​ ​​ ​​ ​setTag(​ ​'agitator_posD',​ ​0); 
​ ​​ ​​ ​​ ​​ ​​ ​​ ​​ ​break; 
​ ​​ ​​ ​​ ​case​ ​3: 
​ ​​ ​​ ​​ ​setTag(​ ​'agitator_posA',​ ​0); 
​ ​​ ​​ ​​ ​setTag(​ ​'agitator_posB',​ ​0); 
​ ​​ ​​ ​​ ​setTag(​ ​'agitator_posC',​ ​1); 
​ ​​ ​​ ​​ ​setTag(​ ​'agitator_posD',​ ​0); 
​ ​​ ​​ ​​ ​​ ​​ ​​ ​​ ​break; 
​ ​​ ​​ ​​ ​case​ ​4: 
​ ​​ ​​ ​​ ​setTag(​ ​'agitator_posA',​ ​0); 
​ ​​ ​​ ​​ ​setTag(​ ​'agitator_posB',​ ​0); 
​ ​​ ​​ ​​ ​setTag(​ ​'agitator_posC',​ ​0); 
​ ​​ ​​ ​​ ​setTag(​ ​'agitator_posD',​ ​1); 
​ ​​ ​​ ​​ ​​ ​​ ​​ ​​ ​break; 
} 

 
We will briefly explain the script. The first line is a remark or comment. A comment begins with // on a                     
line. Anything after // on the same line will not be executed. The script then gets the value of tag                    
agitator_pos and stores the value in a variable. Next, we add this value by 1. By calling this script every                    
second, the variable will change from 1 to 4 with an increment of 1 every second. After the value                   
changes to 4, it will be reset to 1 and the cycle repeats. The next part of the script sets the tag value of                        
agitator_posA to 1 if value of agitator_pos is 1. The tag value of agitator_posB is set to 1 if the value of                      
agitator_pos is 2. Similarly, agitator_posC is set to 1 if agitator_pos is 3 and agitator_posD is set to 1 if                    
the​ ​agitator_pos​ ​is​ ​4. 
 
Ensure that the script is enabled or it will not run. In the Trigger field, select SEC01 to run this script                     
every​ ​second. 
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Figure​ ​6.2​ ​:​ ​Server-side​ ​Scripting 
 
Finally, we restart the Script task in Ecava IGX Server. Highlight 'Script' task and select Tools > Restart                                   
Task​ ​(or​ ​hit​ ​F5).​ ​Refresh​ ​your​ ​Internet​ ​Explorer.​ ​Your​ ​candy​ ​factory​ ​is​ ​now​ ​mixing​ ​a​ ​batch​ ​of​ ​candy. 
 

Quiz​ ​4 
1. From your previous Quiz, create a server-side script to activate System Fault Alarm Beacon               
for 'pump trip' or 'tank level above 8000m3'. Print screen your PE, show the newly added script                 
and​ ​save​ ​its​ ​screen​ ​shot​ ​as​ ​08ServerScript.png​ ​in​ ​your​ ​Quiz​ ​folder. 
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Chapter​ ​7:​ ​Client-side​ ​Scripting 
 

Client-side​ ​scripting 
The web defines server-side scripts as programs that are performed by the server in client-server               
networking. Common operations such as scaling and logging are generally done at server side. An               
advantage​ ​is​ ​that​ ​this​ ​lightens​ ​the​ ​work​ ​of​ ​clients. 
 
The client-side scripts generally refer to scripts running in the client's web browser. User input may be                 
different or environmental conditions are different such as the time of day. An advantage is that this                 
reduces​ ​unnecessary​ ​load​ ​on​ ​the​ ​server. 
 
An important point to note is that client-side scripts will only run when they are activated in the web                   
browser. For scripts that are required to run without a web browser, it is best they are configured at the                    
server​ ​side​ ​in​ ​PE. 
 

Inkscape​ ​SAGE​ ​Script 
While server-side scripts are configured at the PE, client-side scripts are done by using Inkscape               
SAGE and HTML. In this tutorial, we will show you a simple script to top up all tanks with a click of a                       
button. 
 
Using Inkscape SAGE, open overview.svg in “C:\Documents\IntegraXor Projects\Candy” and add a           
button using the Rectangle tool. Label it as 'Top-up all'. Right click the button and select Object                 
Properties.​ ​Select​ ​Script​ ​and​ ​enter​ ​the​ ​following​ ​script​ ​into​ ​the​ ​script​ ​field​ ​as​ ​shown​ ​below. 
 

Figure​ ​7.1​ ​:​ ​Inkscape​ ​SAGE​ ​Script 
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Save​ ​the​ ​overview.svg​ ​file,​ ​refresh​ ​Internet​ ​Explorer​ ​and​ ​test​ ​your​ ​script. 

 

More​ ​scripts 
In addition to the extensive JavaScript resources on the Internet, you can refer to the Ecava IGX User                                   
Guide​ ​for​ ​a​ ​complete​ ​list​ ​of​ ​specific​ ​commands​ ​such​ ​as​ ​getTag​ ​and​ ​setTag. 

 

Quiz​ ​5 
1. Then open My Documents > ​IntegraXor ​Projects > <your initials> > overview.svg, create two                
command buttons to command pump start/stop and valve open/close using client-side script            
method. Print screen the Object Properties of your two command buttons and save as              
09Pump.png​ ​and​ ​10Valve.png​ ​in​ ​your​ ​Quiz​ ​folder.  
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Chapter​ ​8:​ ​HTML 
 

HTML​ ​Basics 
HTML (Hypertext Markup Language) describes how a web browser should display a document. To              
write a HTML file, start by composing the text you want to display, then insert suitable HTML tags in the                    
right places. Do not confuse the HTML tags with the data tags that you created in PE. Every HTML tag                    
begins with < and ends with >. Tags tell a browser to do something special, such as showing an image,                    
linking​ ​to​ ​another​ ​web​ ​page​ ​or​ ​showing​ ​text​ ​in​ ​italic.​ ​HTML​ ​is​ ​also​ ​very​ ​easy​ ​to​ ​learn.  
 

Your​ ​First​ ​HTML 
Copy​ ​and​ ​paste​ ​the​ ​following​ ​into​ ​Notepad.​ ​Then,​ ​save​ ​the​ ​file​ ​as​ ​hello.htm. 
 
<html> 

<head> 
<title>Hello,​ ​world</title> 

</head> 
<body> 

Hello,​ ​world. 
</body> 

</html> 

Open hello.htm in Internet Explorer. In the above example, the <html> </html>, <head> </head> and               
<body> </body> are called container tags. All displayed text, images, hyperlinks, SVG and so on are                
placed​ ​between​ ​<body>​ ​and​ ​</body>​ ​tags. 
 

Figure​ ​8.1​ ​:​ ​First​ ​HTML 
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Unlike the above example, Ecava IGX cannot be run by directly opening the HTML file in Internet                 
Explorer. An Ecava IGX project page must be viewed by connecting to the Ecava IGX server using a                  
web browser. Previously, we set up a sample project called 'Candy' and opened a browser to view its                  
page​ ​at​ ​http://localhost:7131/Candy/index.html. 
 
Now, take a look at your project's index.html. You can open it with a text editor such as Notepad. We                    
have​ ​created​ ​this​ ​HTML​ ​file​ ​as​ ​a​ ​template​ ​to​ ​produce​ ​the​ ​interface​ ​frames​ ​for​ ​the​ ​project​ ​homepage. 
 

Project​ ​HTML 
In this tutorial, we will add one more tab on your web page that loads a new svg file called newadd.svg                     
to monitor the new section of our factory. First, use Inkscape SAGE to create a new svg and save it as                     
newadd.svg.​ ​Open​ ​a​ ​project​ ​with​ ​PE​ ​and​ ​​ ​click​ ​on​ ​Screen. 
 
Right click on the pane and click New Menu to create a new tab called New Page on your web page.                     
Enter newadd.svg on the New Page tab. Save and refresh your Internet Explorer (during project               
running).​ ​Try​ ​your​ ​modified​ ​web​ ​page.​ ​Click​ ​on​ ​New​ ​Page.​ ​Click​ ​on​ ​Overview​ ​to​ ​return. 

Figure​ ​8.2​ ​:​ ​New​ ​Page 
Also you can add two or more sub-menu under same tab, you just need to right click on a created                    
menu​ ​and​ ​select​ ​New​ ​Sub-menu​. 
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Let's add hello.htm we created earlier under New Page tab along with newadd.svg as              
sub-menu.​ ​Also​ ​enter​ ​'Candy​ ​Factory'​ ​in​ ​General-Title​ ​parameter. 

Figure​ ​8.3​ ​:​ ​New​ ​Sub-Menu 
 
Then​ ​save​ ​and​ ​refresh​ ​your​ ​Internet​ ​Explorer​ ​again​ ​to​ ​see​ ​the​ ​difference. 
 

Calling​ ​HTML​ ​from​ ​SVG 
Try this. Create a new button in overview.svg. Label it as 'Go to Packaging'. Right click and select                  
Object Properties. Select Open animation and enter package.svg in the source field. In the Source               
Type drop down, select URL. In the Dest. Type drop down, select Current Window. Add a page and                  
svg​ ​file​ ​for​ ​this​ ​package.svg​ ​in​ ​PE.​ ​Save​ ​all​ ​and​ ​test​ ​your​ ​button. 
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Figure​ ​8.4​ ​:​ ​Open​ ​Animation 
 

More​ ​HTML 
Have you ever seen a nice web page and wondered whether you can do the same for your                  
HMI/SCADA system? The answer is YES. You can configure your HMI/SCADA system to play videos,               
view camera feeds, view pdf and autocad files and even do email. The possibilities are limitless.                
However,​ ​these​ ​are​ ​beyond​ ​the​ ​scope​ ​of​ ​this​ ​tutorial. 

 

Quiz​ ​6 
1. Modify your previous Quiz's files so that when IntegraXor runs, it will contains project name                
as​ ​your​ ​name​ ​and​ ​four​ ​tab​ ​menu​ ​–​ ​shows; 

•​ ​Main​ ​Menu​ ​-​ ​shortcut​ ​button/icon​ ​to​ ​Plant​ ​Overview,​ ​Alarm​ ​and​ ​Trending​ ​pages 
•​ ​Plant​ ​Overview​ ​-​ ​the​ ​Reservoir​ ​Tank​ ​system​ ​mimic 
•​ ​Alarm​ ​-​ ​alarm​ ​status​ ​page 
•​ ​Trending​ ​-​ ​trending​ ​page 

Print screen your Main Menu and Plant Overview page and save as 11Mainmenu.png and              
12PlantOverview.png​ ​in​ ​your​ ​Quiz​ ​folder.  
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Chapter​ ​9:​ ​Alarms 
 

Alarm​ ​Management 
Alarms are useful to inform the user that a condition has exceeded the design limit. Configuration of                 
alarms is done in PE. The template project contains an alarm page with all the standard features                 
included. 
 

Alarm​ ​Configuration 
Alarm configuration begins with a tag. Here, we will monitor the level_vanilla value. If our level_vanilla                
goes below 20, we want to generate an alarm. We will compose a message to alert the user of the                    
condition.​ ​Our​ ​alarm​ ​message​ ​will​ ​be​ ​“Vanilla​ ​tank​ ​level​ ​LOW”. 
 
In​ ​PE,​ ​select​ ​Process​ ​under​ ​Alarm​ ​tree.​ ​Add​ ​a​ ​new​ ​alarm​ ​and​ ​enter​ ​the​ ​following: 
Enable Yes 

Name va_lo 

Message Vanilla​ ​tank​ ​level​ ​LOW 

Tag​ ​Name level_vanilla 

Trigger​ ​By Compare​ ​Value 

Condition Less​ ​Than​ ​(<) 

Limit​ ​1 20 
 
 

 
Figure​ ​9.1​ ​:​ ​Alarm​ ​Configuration 
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Go​ ​ahead​ ​and​ ​add​ ​the​ ​alarms​ ​for​ ​the​ ​other​ ​tanks​ ​as​ ​well. 
Restart the Alarm task at Ecava IGX Server. Test the alarm by varying the value of level_vanilla. Also,                  
try​ ​to​ ​acknowledge​ ​the​ ​alarm​ ​and​ ​see​ ​the​ ​result. 
 

Figure​ ​9.2​ ​:​ ​Alarm​ ​Viewer 
 

Quiz​ ​7 
1. Modify your previous Quiz files so that when Ecava IGX Server runs, it will display an alarm                                   
message when the pump trip signal is active and when the tank level is above 8000m3. Print screen                                   
your​ ​alarm​ ​page​ ​and​ ​save​ ​the​ ​screenshot​ ​as​ ​13Alarm.png​ ​in​ ​your​ ​Quiz​ ​folder.   
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Chapter​ ​10:​ ​Trending 
 

Process​ ​Trending 
A trend chart displays the direction changes of a tag value over time. Not every SCADA project                 
requires trending. We will configure a simple trend chart to monitor some new tags . The template                 
project​ ​has​ ​a​ ​trend​ ​page​ ​with​ ​all​ ​the​ ​standard​ ​features​ ​included. 

Trend​ ​Configuration 
We​ ​will​ ​begin​ ​by​ ​creating​ ​2​ ​virtual​ ​tags​ ​to​ ​trend.​ ​Create​ ​the​ ​following​ ​tags​ ​in​ ​PE. 
​ ​Name ​ ​Data​ ​type ​ ​Log 
​ ​package_output ​ ​int16 ​ ​mdb 

​ ​package_defect ​ ​int16 ​ ​mdb 
 
We will need these values to be changing. Again, we use the time in seconds to simulate this. Copy the                    
following​ ​script​ ​and​ ​paste​ ​it​ ​at​ ​the​ ​end​ ​of​ ​your​ ​run.js. 
 
var​ ​myt​ ​=​ ​getTag(​ ​'app.currentTime.second'); 
setTag(​ ​'package_output',​ ​myt); 
setTag(​ ​'package_defect',​ ​60-myt); 
 
Next, go to Screen tab and edit plot.htm (Trend > Single Layer menu). Note that a Trending object can                   
be expand by clicking on the menu node. You may right click to create a group called Package, enter                   
Unit​ ​as​ ​kg,​ ​and​ ​then​ ​set​ ​Min​ ​&​ ​Max​ ​range​ ​from​ ​0​ ​to​ ​100​ ​respectively. 
 

 
Figure​ ​10.1​ ​:​ ​Edit​ ​plot.htm 
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After that, right click to create new childs to associate with 2 tags. Save plot.htm and restart your                  
project. Open a web browser and access the project page. Click on the Trend tab to view your trend                   
chart. 
 
You will find that the trend chart updates itself every 5 seconds. This is because the database mdb has                   
been configured to log data every 5 seconds. You can scroll to view historical trends. Use the zoom                  
function to zoom in and out. You can also click on the start time and end time to manually change the                     
range. 
 

Figure​ ​10.2​ ​:​ ​Trending 
 

Quiz​ ​8 
1. Modify your previous Quiz files so that when Ecava IGX Server runs, it will show 3 more                  
trending​ ​graphs​ ​under​ ​Trend​ ​>​ ​Single​ ​Layer​ ​tab​ ​for: 

•​ ​Level​ ​–​ ​Tank​ ​Level​ ​trending​ ​graph 
•​ ​pH​ ​–​ ​Tank​ ​pH​ ​trending​ ​graph 
•​ ​Flow​ ​rate​ ​–​ ​Outlet​ ​Flow​ ​rate​ ​trending​ ​graph 

Save​ ​the​ ​trend​ ​page​ ​screenshot​ ​as​ ​14Trend.png.  
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Chapter​ ​11:​ ​Database​ ​&​ ​More 
 

Database​ ​Management 
Ecava IGX uses Open Database Connectivity (ODBC) to log data into different databases. This              
ensures compatibility with a wide range of databases from free Open Source databases to the large                
commercial​ ​databases​ ​such​ ​as​ ​Oracle​ ​and​ ​Microsoft​ ​SQL​ ​Server. 
 

Microsoft​ ​Access 
By default, the template project is configured to log user data to an Access database called dblog.mdb.                 
In PE, select the Database tab. There is configuration called mdb which connects to the dblog.mdb in                 
the​ ​project​ ​folder.​ ​It​ ​is​ ​configured​ ​to​ ​log​ ​every​ ​5​ ​seconds. 
 
In other sections of PE, you might find a “Log” field. For example, in our Alarm configuration, we have                   
selected​ ​the​ ​alarm​ ​data​ ​to​ ​be​ ​logged​ ​to​ ​mdb. 
 
In our Tag configuration, if we select “Log”, the data will be logged to dblog.mdb every 5 seconds. Go                   
ahead​ ​and​ ​select​ ​mdb​ ​in​ ​the​ ​“Log”​ ​field​ ​for​ ​the​ ​level​ ​tags. 
 
NOTE: Microsoft Access is chosen for quick demo and education purpose only. You shall setup               
professional​ ​database​ ​like​ ​PostgreSQL​ ​for​ ​production​ ​purpose. 
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Figure​ ​11.1​ ​:​ ​Log​ ​data​ ​to​ ​database 
 
Run the project and vary the level data once in awhile. If you have Microsoft Access, you can open the                                       
dblog.mdb and view the contents of 'log_xx' table (where 'xx' is the variable number written to the                                 
database) to verify that your data have been logged successfully. If you have OpenOffice, you can also                                 
connect​ ​to​ ​this​ ​database​ ​and​ ​view​ ​the​ ​contents. 
 

Microsoft​ ​SQL​ ​Server 
For those who are familiar with Microsoft SQL Server, you can try to log data to this database. First,                                     
create​ ​a​ ​new​ ​database​ ​for​ ​your​ ​Ecava​ ​IGX​ ​project​ ​in​ ​your​ ​SQL​ ​Server. 
 
In PE, an MS SQL Server Express connection named '_mssql' has been configured as an example.                               
Alternatively,​ ​you​ ​can​ ​create​ ​your​ ​own​ ​ODBC​ ​and​ ​enter​ ​the​ ​connection​ ​string​ ​details​ ​in​ ​PE. 
 

Other​ ​Databases 
Similar to Microsoft SQL Server, other databases can also be configured for logging data. We will                               
continue to add SQL scripts for various databases. Check with us if you need assistance with any                                 
database. 
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End​ ​of​ ​Tutorial 
This is the end of our tutorial. We will leave the user to explore the Security feature on his or her                                         
own.​ ​Tip:​ ​Refer​ ​to​ ​our​ ​User​ ​Guide​ ​in​ ​PE​ ​for​ ​details. 
 
We are also working on further improvement to the product as well as adding more features and                                 
modules. Check with us from time to time to find out about these improvements. We also welcome                                 
suggestions​ ​on​ ​how​ ​to​ ​improve​ ​the​ ​product​ ​further. 

 

Quiz​ ​9 
1. Make your final touch. Remove all unwanted files, device, tags and alarm in your previous Quiz                                 
folder.​ ​Also​ ​try​ ​to​ ​improve​ ​your​ ​graphic​ ​and​ ​SCADA​ ​function. 
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Chapter​ ​12:​ ​Conclusion 
“INFORMATION TECHNOLOGY AND BUSINESS ARE BECOMING INEXTRICABLY INTERWOVEN. I DON'T THINK           
ANYBODY​ ​CAN​ ​TALK​ ​MEANINGFULLY​ ​ABOUT​ ​ONE​ ​WITHOUT​ ​THE​ ​TALKING​ ​ABOUT​ ​THE​ ​OTHER.” -​ ​BILL​ ​GATES 

 

Future​ ​of​ ​Industrial​ ​Automation 
 
Companies must keep innovating to compete in the globalized world. Industrial automation can no                           
longer continue to play the role of guardians of machinery, production and safety without innovation.                             
Automation systems must easily adapt to changes just like how the PLC is designed to be                               
programmable​ ​for​ ​high​ ​adaptability. 
 
A website on the Internet changes very quickly to meet the current business needs and requirements.                               
Similarly, a HMI/SCADA system must also be able to adapt quickly to the same needs. With Ecava IGX,                                   
we​ ​hope​ ​to​ ​bring​ ​the​ ​HMI/SCADA​ ​technology​ ​closer​ ​to​ ​this​ ​goal. 
 

Contact​ ​Us 
 
We​ ​welcome​ ​any​ ​comments​ ​or​ ​suggestions.​ ​Reach​ ​us​ ​at: 
https://www.integraxor.com/support/ 
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